
The Villages Computer Club 

There is a special event at the recreation center this week. 

The next meeting will be July 19
th

 at La Hacienda. 

For information or to sign up to be on the VCC email list, visit the 

website or email Paul Rabenold at TVCC.Pres@gmail.com 

******************************************** 

Java in a nutshell... 
 

1) Java is a programing language. 

2) What's installed on your pc is considered the "JVM" or Java Virtual Machine. 

3) It's the "client" pieces needed to run java programs from a website. 

4) Previous versions are typically not uninstalled, because different web-based programs 

may require different versions of the Java client. 

5) Multiple versions can co-exist on the same machine with RELATIVELY minor conflicts. 

 

6) by default install, the java client will periodically check for available updates, which are 

released roughly every month or so. 

 

7) You can turn off the update though. Go into CONTROL PANEL, and click the JAVA icon. 

Depending on your current version the option to turn off auto-updating of java is typically 

on the "Advanced" or "Updates" tab. 

 

There's really no need to constantly update it, any web-based program which requires it, 

will prompt you when an update is absolutely required.  

 

*********************************************************** 

ADDRESS TOOLBAR 

 

One of Windows most powerful hidden gems is a universal command line. From 

here you can launch programs, open folders, go to Web sites and more. Right-click 

on the taskbar and select Toolbars/Address.  The address bar will now show up on 

the taskbar. 

 

If you’re in the middle of doing something and need info you can type 

www.google.com and click ENTER to go to that web site, if you’re signed online 

already. 

***************************************************************** 



Block Senders in Windows Live Email 

 

To add a sender to your list of blocked senders in Windows Live Mail or Windows Mail:  

• Highlight a message from the undesired sender in the message list.  
• Make sure the Home ribbon is active.  
• Click the down arrow beneath Junk in the Home ribbon.  
• Select Add sender to blocked sender list from the menu.  

o Select Add sender's domain to blocked sender list from the menu to block 
messages not only from this sender but from all addresses at the same 
domain (what follows the '@' sign).  

Block a Sender in Windows Live Mail 2009 (and Earlier) or Windows Mail 

To add a sender to your list of blocked senders in Windows Live Mail or Windows Mail:  

• Open a message from the undesired sender or highlight it in the message list.  
• Select Actions | Junk e-mail | add sender to blocked senders list (Windows Live 

Mail) or Message | Junk E-mail | Add Sender to Blocked Senders List (Windows 
Mail) from the menu.  

o Select Actions | Junk e-mail | Add sender's domain to blocked senders list 
(or Message | Junk E-mail | Add Sender's Domain to Blocked Senders 
List) from the menu to block messages not only from this sender but from 
all addresses at the same domain (what follows the '@' sign).  

o In Windows Live Mail, you may have to hold down the Alt key to see the 
menu.  

******************************************************************************************* 
Downloads Organized 

 

1.  Create a new folder on  C:\ drive and  name it AHOLDING TANK. 

 

Easy to do, just go to Explore, scroll to the top and click to select the C:\ drive then click 

FILE...NEW...FOLDER.  Name it and doubleclick.  The folder has been created and can now be 

seen at the top of the Explore list.  

 

2.Create a 2nd new folder on the C:\ drive and name it ADOWNLOAD.   

The A in front causes it to be listed near the top of the list of folders in Drive C:\. 

 

Open your email program, if AOL  without signing online, click File….Download Manger.(Or 

whatever you click to set download preferences in your email program)  A screen comes up with 

a box at the bottom that says C:\Program Files\America Online \Download.  This is the default 

folder set by AOL to send downloads. Change this line to read C:\AHolding Tank.  Now 

anything you download from AOL emails will go to the AHolding Tank folder.   

 



3.If you download a program, when the box comes up with the choices to RUN or SAVE, click, 

SAVE.  Then click the down arrow in the top box and select C:\ drive and then doubleclick the 

ADOWNLOAD folder.  This causes the program to go to the ADOWNLOAD folder in your 

C:\drive .  Periodically, copy this ADOWNLOAD folder to a cd if you have a cd-writer. If you 

ever need to reinstall drivers or programs that you’ve saved to this ADOWNLOAD folder, they 

will be there waiting. It is also a good idea to create a sub folder for each program you download 

so that the install file is easy to find.  For instance, AVG, AOL, McCafee, HP Printers,etc and 

then download the file or driver to that folder. 

 

Should the computer's hard drive fail, I  can put in my Download CD that contains my 

ADOWNLOAD folder  and reinstall them when my computer is up and running again.  If 

computer crashes, the Recovery disk can be used to recover all software and system files just as 

when the computer came from the factory. My Downloads CD can be used to reinstall other 

programs I've added to my computer 

***************************************************************** 
CALLER ID ON THE WEB 

 
www.anywho.com Offers dead-on reverse telephone lookup 

 
www.infospace.com It’s your internet snooping starting point:reverse lookups plus links to hundreds of 

ways to track people down. 

 
www.infousa.com Reverse lookups, business info, sales leads. 
 
www.sorabji.com/livewire/payphones  Indexes thousands of pay-phone numbers worldwide. 
 
Peoplesearch.net Reverse lookups for email and street addresses and phone numbers. 
 

 
Want to help stop the Spammers? 
The best way is to find out who they are and report them.  To decode the message header, look for IP 
 addreesses or domain names inside parentheses in the header’s Received lines (info outside the parentheses 
 can be faked).  An IP address is four numbers from 1-255 separated by periods.  Read the Received lines  
from bottom to top to trace the path the message took from the spammer to you. Verify the address using  
Acme address digger (samspade.org). Finally tattle on the spammer at the Network Abuse Clearinghouse 
 (www.abuse.net) 
Note: 169 as the first 3 digits of an IP address indicates this is a false ID.   
******************************************************************************

** 

 

Changing Web page fonts and background colors 

When Web authors and designers create Web pages, they often specify particular type (font) 

faces, colors, sizes, and background colors. These settings are specified for each item, or in a 

"style sheet", which is a type of template for specifying how different styles should appear 

throughout a Web page or site. 



You can override any or all of these settings, which is useful if you have limited or low vision. 

You can specify your font and color preferences for all pages that do not use style sheets, and 

then you can specify whether to use any or all of your preferences on pages that use style sheets. 

*********************************** 

To change the appearance of the Windows toolbar 

• You can add or remove standard toolbar buttons, use smaller toolbar buttons like the ones 

used in Microsoft Office, and change the order they are displayed on the toolbar. Just 

right-click the toolbar, and then click Customize.  

• You can move or resize the Address bar and Links bar by dragging them up, down, left, 

or right. You can even move them into the menu bar!  

• You can hide the Address bar or Links bar by right-clicking the toolbar, and then clearing 

the check mark for each item you want to hide.  

• You can add items to the Links bar by dragging the icon from the Address bar or 

dragging a link from a Web page.  

• You can rearrange items on the Links bar by dragging them to a new location on the bar.  

To display Web page text larger or smaller 

• On the View menu, point to Text Size, and then click the size you want. . 

To change how Web page colors are displayed 

1. On the Tools menu in Internet Explorer, click Internet Options.  

2. On the General tab, click Colors.  

3. Change the settings as needed.  

To specify fonts and colors to always use for Web pages 

1. On the Tools menu in Internet Explorer, click Internet Options.  

2. On the General tab, click Accessibility.  

3. Change the settings as needed 

******************************************************************************

** 

DNS 

 

The domain name system (DNS) stores and associates many types of information with domain 

names, but most importantly, it translates domain names (computer hostnames) to IP addresses. 

It also lists mail exchange servers accepting e-mail for each domain. In providing a worldwide 

keyword-based redirection service, DNS is an essential component of contemporary Internet use. 



Useful for several reasons, the DNS pre-eminently makes it possible to attach easy-to-remember 

domain names (such as "wikipedia.org") to hard-to-remember IP addresses (such as 

66.230.200.105). Humans take advantage of this when they recite URLs and e-mail addresses. In 

a subsidiary function, the domain name system makes it possible for people to assign 

authoritative names without needing to communicate with a central registrar each time. 

******************************************************************************

************* 

 

 

Dropbox Files Removed 

 
To get files out of Dropbox, just drag them out of Dropbox and into a some other folder on your computer.  As an 

alternative, copy [or cut] the files in Dropbox and paste them into another folder on your computer. To uninstall 

Dropbox - go to Control Panel and to UNINSTALL PROGRAMS. Alternately, go to the Dropbox program and 

click on UNINSTALL. 

 

90 day limit on unused Dropbox storage and Yahoo email Accounts 

Dropbox can shut down the account without notice –  and specifically, IF IT HAS 

NOT BEEN USED FOR 90 DAYS! – so be aware NOT to store for back-up 

purposes and accidentally forget about it for over 90 days. 

Caution:  Never drag and drop a file that you want to keep in your computer into your drop box.  

If you do, and you later delete the dropbox, you've just lost all your files...Always create a COPY 

and drop it into the dropbox. 

 

Click here: Dropbox (service) - Wikipedia, the free encyclopedia  

 

 Also , Yahoo does the same thing with email accounts that have not been used for 

that long – while the account may still be accessible, all the content will be gone. 

****************************************************************************** 
I want to thank the person that sent this to me.  

It gave me much pleasure and pride. 

I hope that all the people that I send this to 

will in turn send to their friends. ENJOY!!  

  

Give it time to load. 

  
Battle Hymn  



JmaxJmaxJmaxJmax  

Jmax's Website   http://www.jmaxbits.com/ 
Jmax Bits Newsletter is now posted each Monday & Thursday on the website. 
You have the option for a .pdf or a .rtf file. 
 
1.For help with a computer problem, put HELP in the subject line and give me info 
about the computer you're using, if you know it.  
 
2.To view or print Jmax Bits Good Services List in the Villages area, click link 
www.jmaxbits.com 
 
3. To sign up for the non-computer newsletter, send an email to 
VLGSClassifieds@aol.com. Put SUBSCRIBE in the subject line. To send an Ad, 
place AD in the subject line. 
 
4. The Villages Computer Club's web page: Click here: Welcome To The Villages 
Computer Club 
To add your name to the VCC announcements list, send email to TheVCC-
subscribe@yahoogroups.com 
 

5. Fred Benson's website www.thevillagescomputerbasics.com  
 


